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Introduction to PowerPoint 
XP 

Online Course 

Contents: Welcome to the Western Region Education Service Alliance Online . 
This is an Introductory level online course consisting of activities and tutorials 
designed for PowerPoint XP. If you have an earlier version of PowerPoint, you 
may notice a few differences in the views and toolbars. The basics however, are 
the same.   

CEU Credit: To receive CEU credit from your LEA, you must register, receive 
confirmation,  complete and submit  all course assignments. Upon completion 
of the course you will be given a certificate which you may send to your Central 
Office for the equivalent CEUs. Important! Some LEAs require prior approval of 
workshops and courses to be submitted for CEUs. 

Course Requirements: Basic familiarity with computers and the Windows 
operating system, PowerPoint XP installed on your computer, Javascript 
enabled,  the ability to send and receive email (including attachments),  and 
completion of all course assignments. 
 

Course Contents: To the left you find a list of course modules. 
Time needed to complete this course: 10 hours 

CEUs awarded by LEA: 1(One) 

Assignments to be submitted: 2 

Module 1: Starting 
PowerPoint: options 

Module 2: Getting oriented: 
views, menus, toolbars 

Module 3: Opening an 
existing presentation; 
saving options 

Module 4: Creating a 
presentation using 
Presentation Templates 

Module 5: Entering text, 
spell-checking, formatting 
text and backgrounds 

Module 6: Creating a 
presentation from Outline 
View 

Module 7: Creating a 
presentation from scratch 

Module 8: Adding 
animation, music, and 
sound to your presentation 
(Assignment  1 Due) 

Module 9: PowerPoint 
Project  (Assignment 2 Due) 

Click here to download the manual for this course in pdf format  

If you need Acrobat Reader to open pdfs you can get it here  
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Introduction to PowerPoint XP 

Module 1 

 

There are several ways to start PowerPoint. This module covers the following: 

      Launching PowerPoint from Start Programs Microsoft PowerPoint 

     Creating a Shortcut to PowerPoint on the Desktop 

   Creating a Shortcut to PowerPoint on the Quick-Launch Toolbar 

      Launching PowerPoint from The New Presentation Menu on the Task Pane 

Launching PowerPoint from Start Programs Microsoft PowerPoint   

 

Activity 1: Launching PowerPoint from Start Programs Microsoft PowerPoint   

1. Start PowerPoint by clicking on the PowerPoint icon in the Start-Programs menu. 

2. PowerPoint opens to a blank title slide layout. 
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To change the layout of an existing 
slide, follow these steps 

1. In normal or slide sorter view, select 
the slide you want to change.  

2. On the Formatting toolbar or in the 
Task Pane, click Slide Layout.  

3. Use the scroll bar to view all layouts, 
then click the one you want.  

4. Rearrange any overlapping or hidden 
objects to fit the new layout.  

 

 Return to index  

 
Creating a Shortcut to PowerPoint on the Desktop   

 

Activity 2: Creating a Shortcut to PowerPoint on the Desktop   

It is easy to create a Shortcut icon to any program, folder, or file and place the shortcut on your desktop. 

1.Go to Start - Programs and find the folder or icon you want (you may also open the My Computer window 
and navigate to the file location) 

2. Right click and hold, then drag and drop onto the desktop 

3. In the resulting pop-up menu choose "Create shortcut here" 

4. To start PowerPoint from the desktop icon, double click 
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A shortcut is a quick way to start a 
program or open a file or folder without 
having to go to its permanent location in 
Windows Explorer. Shortcuts are 
especially useful for programs, files, and 
folders you use frequently.  

To delete a shortcut, drag it to the 
Recycle Bin. The original item still exists 
on the disk. 

Return to index 

 
Creating a Shortcut to PowerPoint on the Quick-Launch Toolbar   

 

Activity 3: Creating a Shortcut to PowerPoint on the Quick-Launch Toolbar   

1.Go to Start - Programs and find the folder or icon you want (you may also open the My Computer window 
and navigate to the file location) 

2. Right click and hold, then drag onto the desktop (do not drop yet) 

3. Drag "Ghost" icon down into the QuickLaunch toolbar and drop 

3. In the resulting pop-up menu choose "Create shortcut here" 

4. To start PowerPoint from the QuickLaunch toolbar, click 
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 If the QuickLaunch toolbar is not showing, right click on the 
Taskbar, point to Toolbars, and then check "QuickLaunch" 

In Windows 98 the QuickLaunch toolbar is located on the 
Taskbar (just to the right of the Start button). Shortcut buttons 
to any folder, file, or program can easily be created on this 
toolbar and the folder, file, or program can be launched with a 
single click. 

Return to index 

 
Launching PowerPoint from The New Office Document Menu   

 

Activity 4: Launching PowerPoint from The New Presentation Menu on the Task Pane   

1. To start a PowerPoint presentation from a template, click on the General Templates button on the Task Pane.

2. Choose a tab at the top of this window to see the available templates. 

 

       
Any Office program can be started from a template. Templates for PowerPoint are located in the New Presentation menu of the Task 
Pane.  

The General tab contains templates for blank presentations using default settings (slide size, fonts, font sizes, colors, etc). It also 
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contains the AutoContent Wizard. Wizards are step by step processes which help you create customized documents  

The Presentations tab contains templates to help you create a presentation based upon generic topics such as "Brainstorming 
Session", Communicating Bad News", "Introducing a Speaker", etc. To use these templates, you simply open them up and replace the 
placeholder text and images with your own content.  

The Design Templates tab allows you to begin a blank presentation by choosing from several professionally created designs which 
include fonts, page designs, and matching color schemes. 

Return to index 

 
You have now completed this module. Take a few minutes to review and practice what you have learned. 
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Introduction to PowerPoint XP 

Module 2 

 

In this module, we will explore the various views, menus, and toolbars found in PowerPoint XP.  

      Normal View - working panes 

       Slide Sorter View 

   Outline View 

       Slide View 

    The Menus 

    The Standard Toolbar 

    The Formatting Toolbar 

    The Drawing Toolbar 

Normal View - working panes: Microsoft PowerPoint comes with different views to help you while you are 
creating a presentation. The two main views you use in PowerPoint are normal view and slide sorter view. To 
easily switch between views, you click the buttons at the lower left of the PowerPoint window. 

 

Activity 1 - Normal View - working panes:   

1. Start PowerPoint by clicking on the PowerPoint icon in the Start - Programs menu.  

2. PowerPoint opens a presentation in the Normal View.  Explore the three panes in Normal view. When you 
are through, close the presentation. 
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Normal view 

Normal view contains 
three panes: the 
outline pane, the slide 
pane, and the notes 
pane. These panes let 
you work on all 
aspects of your 
presentation in one 
place. You can adjust 
the size of the 
different panes by 
dragging the pane 
borders.  

You will also see the 
Task Pane on the 
right side. We will 
talk more about this 
later. 

  

 

Outline pane:   Use the outline pane 
to organize and develop the content 
of your presentation. You can type 
all of the text of your presentation 
and rearrange bullet points, 
paragraphs, and slides. 

Slide pane:   In the slide pane, you 
can see how your text looks on each 
slide. You can add graphics, movies, 
and sounds, create hyperlinks, and 
add animations to individual slides. 

Notes pane:   The notes pane lets 
you add your speaker notes or 
information you want to share with 
the audience. If you want to have 
graphics in your notes, you must 
add the notes in notes page view. 

Return to index 

 
Normal View - working panes 

  

Activity 2 - Normal View - working panes:  

1. Start PowerPoint by clicking on the PowerPoint icon in the Start - Programs menu. PowerPoint opens to a 
blank slide.  

2. Choose Open a Presentation – More Presentations from the Task pane. If the task pane is not visible, 
go to the view menu and click Task Pane to show it.   

3. Open the practice file Sample PowerPoint Presentation.ppt (Right click and choose save Target As) 
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We will use this sample presentation  to demonstrate several PowerPoint navigation techniques, views, menu 
options, toolbars etc. 

 

 

In the lower left-hand 
portion of the Outline 
pane, you see the 
following toolbar 

 

This is called the Views 
toolbar. The first button 
is applied by default and 
indicates the Normal 
view. Moving right, you 
see Slide Sorter view, 
and Slideshow. If you 
click on a button, your 
working view changes. 

Return to index 

 
Slide Sorter View: In Slide Sorter View, you can see all the slides in your presentation. This view is useful 
when you are putting the finishing touches on your presentation. 
Activity 3 - Slide Sorter View:  

Switch to Slide Sorter view. (You may also do this from the View menu at the top of your page). 

 

In slide sorter view, you see all the slides in your presentation on screen at the same time, displayed in miniature. This makes it easy to 
add, delete, and move slides, add timings, and select animated transitions for moving from slide to slide.  
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Return to index 

 
Activity 4 - Slide Sorter View:  

Rearrange the slides in your presentation by dragging and dropping. Click and hold slide 4 and then drag it to 
the beginning of the presentation. When you drop (release the mouse button) it becomes slide 1 and all the other 
slides move to their new positions. 

Outline View: Working in Outline view allows you to concentrate on the content of the slide instead of the 
appearance. Slide View is better when you are concerned with design and visual characteristics. 
Activity 5 - Outline View, Slide View:  

Practice toggling between the different working views: Normal , Slide Sorter, Outline, and Slide. 
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Outline View  

  

  

 

Outline/Slides View 

   

Return to index  

 
The Menus, The Standard Toolbar, The Formatting Toolbar, The Drawing Toolbar: Microsoft Office 
uses standard menus and toolbars in all their programs (PowerPoint, Word, Excel, etc). Once you are familiar 
with one of these programs, learning others is much easier. 

 

Activity 6 - The Menus, The Standard Toolbar, The Formatting Toolbar, The Drawing Toolbar:  

1. Change to Slide View, if necessary.  

2. Examine the menus, File, Edit, View, Insert, and Format.  
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3. Move your mouse pointer over each of the buttons on the Standard, Formatting, and Drawing toolbars.  

4. When you are through, close PowerPoint. Do not save any changes. 

 

  

 

 

You will learn more about the 
drawing toolbar, autoshapes, the 
picture toolbar, tables and borders 
toolbar and the wordart toolbar as you 
progress in the course. 

  

 

 
 

You have now completed this module. Take a few minutes to review and practice what you have learned. 
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Introduction to PowerPoint XP 

Module 3 

 

PowerPoint files are opened and saved just like any other file. In this exercise you will open the file 
you downloaded in the previous module and then save it under a different name. 

      Opening a PowerPoint Presentation  

   Saving a PowerPoint presentation 

Opening a PowerPoint Presentation : 

 

Activity 1 - Opening a PowerPoint Presentation   

1. On the Standard toolbar, click Open .  

2. Click a shortcut on the Places Bar or, in the Look in box, click the drive, folder, or Internet location that 
contains the presentation you want.  

3. In the folder list, locate and open the folder that contains the presentation.  

If you can't find the presentation in the folder list, you can search for it. 

5. Double-click the presentation you want to open.  

Tip   To open a file you've used recently, click History on the Places Bar. You can also click the file name 
at the bottom of the File menu. If the list of recently used files isn't displayed, click Options on the Tools 
menu, click the General tab, and then select the Recently used file list check box. 
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You may also Open an 
Existing presentation from 
the Task Pane. Remember 
to click the down arrow 
and choose New 
Presentation. 

 

Return to index  

 
Saving a PowerPoint presentation  

 

Activity 2 - Saving a PowerPoint presentation 

1. To save a presentation, go to the file menu and choose "Save As".   

2. In the Save As dialogue box, click on the My Documents button to switch to that folder.  

3. Create a new folder by clicking on the "New folder" button 

4. In the New Folder dialogue box type a name for the folder, in this case, "My Folder" and click OK.  

5. In the Save As dialogue box, in the "File Name" box, select the current file name and type "My Sample"  

6. In the "Save as type" box, click the down arrow and select "presentation" 

7. Click the "Save" button 

8. PowerPoint saves the presentation to the "My Presentations" folder and renames it "My Sample" 
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Save a copy of a presentation  

1. On the File menu, click 
Save As.  

2. In the File name box, enter 
a new name for the 
presentation.  

3. Click Save.  

Tip   To save the copy in a different 
folder, click a different drive in the 
Save in box or a different folder in 
the folder list, or both. To save the 
copy in a new folder, click Create 
New Folder . 

  

Return to index 

 
You have now completed this module. Take a few minutes to review and practice what you have learned. 
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Introduction to PowerPoint XP 

Module 4 

 

PowerPoint features two ways to create presentations without having to spend a lot of time 
designing and formatting—the AutoContent Wizard and Presentation Templates. 

      Create a presentation based on suggested content and design   

   Create a presentation based on a design template 

Create a presentation based on suggested content and design : 

 

Activity 1 - Create a presentation based on suggested content and design  :  

1. On the File menu, click New, and then click the General tab. 

2. In the Task pane click From AutoContent Wizard, and then follow the instructions in the wizard. 

3.PowerPoint opens a sample presentation that you can add your own words and pictures to.  

4.Change the sample presentation to suit your needs. 

5.For example, type your text in place of the sample text, add or delete slides, and add pictures or other items 
that you want. 

6. When you finish, click Save on the File menu. 

7. Name your presentation, and then click Save. 
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Use the AutoContent Wizard. If you do not have 
PowerPoint Open, open it from the Start-Programs menu 
and choose AutoContent Wizard from Task Pane: On the 
first screen of the wizard, click Next. On the second screen, 
choose the General button and Generic; click Next. On the 
third screen, choose On-screen presentation and click Next. 
On the fourth screen, type a title and click Finish. 
PowerPoint creates your presentation. You may modify the 
slides by adding your own content. 

Return to index 

 
Create a Presentation Based on a Design Template 

 

Activity 2 - Create a Presentation Based on a Design Template:  

1. On New Presentation tab of the Task Pane, choose  From Design Templates.   

2. Scroll to see all the design templates, click the one you want, and then click the down arrow of the template 
and choose Apply to All Slides.  

3. By default, the first slide in a presentation uses the title slide layout. If you want to use a different layout, 
switch to the Slide Layout tab of the Task Pane.  

4. Type the title and any other content you want on the title slide.  

5. On the Formatting toolbar, click New Slide, and then select a layout for the next slide.  

6. Add the content you want.  

7. Repeat steps 5 and 6 for each new slide.  

8. When you finish, click Save on the File menu.  

9. Name your presentation, and then click Save. 
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Another way to start a presentation is by selecting a 
design template that determines the presentation's 
design but doesn't include content. You can also begin 
with an outline you import from another application or 
with a blank presentation that has neither suggested 
content nor design 

 

   

 
You can create your own 
Presentation Templates on which 
to base future presentations. Simply 
save your model as a PowerPoint 
template (.pot) 

      

Return to index 

 
You have now completed this module. Take a few minutes to review and practice what you have learned. 
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Introduction to PowerPoint XP 

Module 5 

  

In this module, you will learn about using slide layouts, entering, editing, and  formatting text, and  
selecting and formatting backgrounds in PowerPoint XP.  

      Selecting and Changing Slide Layouts 

      Creating Text Boxes with the Text Tool 

   Entering Text 

      Formatting Text 

   Formatting the Background (and the text) Using Presentation Designs 

   Changing the Slide Color Scheme 

   Changing the Background Fill (Colors, Shading, Patterns, Picture) 

Selecting and Changing Slide Layouts: In PowerPoint, text is entered in text boxes. Various layouts contain pre-
formatted text boxes with placeholder text. Clicking in a layout text box allows you to replace that text with 
your own. 

 

Activity 1 - Selecting and Changing Slide Layouts: 

1.Start PowerPoint by clicking on the PowerPoint icon in the Start - Programs menu. By default, PowerPoint 
creates a Tile layout slide. Thereafter, each time you insert a new slide, the Bulleted List layout is used. 
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Available slide layouts include Title Slide, Bulleted List, 2 
Column Text, Table, Text & Chart, Chart & Text, 
Organizational Chart, hart, Text and Clipart, Clipart & Text, 
Title Only, Blank, etc. 

2.You may change the Slide Layout at any time by going to the Task Pane > Slide Layout tab to bring up the 
available layouts.   

Return to index 

 
Creating Text Boxes with the Text Tool: Most often, the easiest way to add text to a slide is to type it directly into any 
placeholder on the slide. If you want to add text outside a placeholder or shape, you can use the Text Box button 
on the Drawing toolbar. You can also add text to an AutoShape or add a WordArt drawing object for a special 
text effect. 

 

Activity 2 - Creating Text Boxes with the Text Tool: 

1. On the Drawing toolbar, click Text Box. 

2. To add text that doesn't wrap, click where you want to add the text, and start typing. To add text that does 
wrap, drag to where you want to add text, and then start typing. 

Note:   To change the shape of a text box to any AutoShape, select the text box, click Draw on the Drawing 
toolbar, point to Change AutoShape, point to a category, and then click the shape you want. (You must choose 
a line color from the drawing toolbar to see the box). 
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Text boxes are 
objects – just like 
clip art or 
pictures. They 
may be resized or 
moved to any 
position on a 
slide. Resizing a 
text box changes 
the text wrapping 
to fit the text box 
size. Text that 
normally is 
presented on one 
line may wrap to 
two lines or more 
if the text box is 
made smaller. 

 

Text boxes of 
specific sizes 
(width) may be  
created by 
clicking and 
dragging. Text 
typed inside one 
of these boxes 
will wrap within 
the boundaries of 
the box. 
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To rotate text, 
select the text box 
and choose "Text 
Box" from the 
Format menu. 
Click on the Text 
Box tab and check 
the box labeled 
Rotate text 
within 
AutoShape by 
90*. 

 

Text boxes are 
objects – just like 
clip art or 
pictures. They 
may be resized or 
moved to any 
position on a 
slide. Resizing a 
text box changes 
the text wrapping 
to fit the text box 
size. Text that 
normally is 
presented on one 
line may wrap to 
two lines or more 
if the text box is 
made smaller. 

Return to index 

 
Entering Text: To enter text into a placeholder text box, click in the box and then type. 

 

Activity 3 - Entering Text:  

1.In the Title box, type “PowerPoint” (without the quotes). 
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2.In the subtitle box, type your name. 

3.On the Insert menu, click on New Slide  

4.On this slide, type the title Four Things I Have Learned. 

5.Finally, add four bullets. Click in the bulleted list box, type your first bullet, and hit the Enter key to go to the 
next bullet. Backspace to remove a mistake. 

 

  

Text can be positioned within a text 
box by using the alignment buttons 
on the toolbar: 

 

Return to index 

 
Formatting Text: Text may be formatted by choosing Font from the Format menu. 
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Activity 4 - Formatting Text:  

1.Select the text you wish to format. 

2.From the Format menu, choose  
Font. 

3.You will see the Font dialogue 
box. 

4.Scroll up in the Font window to 
choose Arial. In the Font Style 
window choose Bold. In the size 
window choose 40. Click the down 
arrow in the color box to see colors 
in use in your selected color 
scheme. You may choose different 
colors by clicking on the More 
Colors... option. Notice the different 
effects (underline, shadow, etc. that 
are available. 

5. Many formatting options are 
available from the Formatting 
Toolbar . 

6.Practice formatting the text on 
your slide(s). Use the Undo arrow 
on the Standard Toolbar to reverse 
any changes that you apply 
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To format any object, including 
text, you must first select it.  A 
shortcut: when you select an object, 
right click it and choose 
Format…Object (Text) from the 
pop-up menu. To select all the text 
in a text box, click on the hash mark 
border (it will change into a spotted, 
or “fuzzy” border. A picture or 
piece of clip art can be selected by 
clicking anywhere on the picture. 
(Sizing handles –little boxes—will 
appear at the corners and midpoints 
of the object) 

Return to index 

 
Formatting the Background (and the text) Using Presentation Designs: Design templates contain color schemes, slide and 
title masters with custom formatting, and styled fonts, all designed to create a particular look. When you apply a 
design template to your presentation, the slide master, title master, and color scheme of the new template 
replace the slide master, title master, and color scheme of the original presentation. After you apply a design 
template, each slide you add has the same custom look. 

 

Activity 5 - Formatting the Background (and the text) Using Presentation Designs:  

1.From the Format menu, choose Slide Design. 

2.Preview available designs, choose one and click Apply. 
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There are several ways to format the 
background; one of them is to apply 
a Presentation Design. This will 
not only format your background, 
but also apply formatting to text that 
you have typed into the layout 
fields. It is important to remember 
that when you choose a design 
template, it is applied to each slide 
in your presentation. 

Return to index 

 
Changing the Slide Color Scheme: Color schemes are sets of eight balanced colors designed for use as the main 
colors of a slide presentation —for text, background, fill, accents, and so on. Each color in the scheme is used 
automatically for a different element on the slide. You can pick a color scheme for an individual slide or for an 
entire presentation. When you apply a design template to a presentation, you can choose from a set of pre-
designed color schemes made to go with that design template. This makes it easy to change color schemes for a 
slide or an entire presentation and know that the new color scheme will harmonize with the rest of the slides in 
your presentation. 

 

Activity 6 - Changing the Slide Color Scheme:  

1.Display the slide you want to change. 

2.On the Task Pane – Slide Design tab, choose Color Schemes.  

3.Click the color scheme you want, and then click Apply. You may also choose to apply the scheme to all slides 
in the presentation. 

Return to index 

 
Changing the Background Fill (Colors, Shading, Patterns, Picture): You can change the appearance of your slide 
background by changing its color, shade, pattern, or texture. You can also use a picture as a slide background, 
but you can use only one type of background on a slide or master. For example — you can have a shaded 
background, a textured background, or a picture as the background, but you can use only one of these on a 
single slide. When you change the background, you can apply the change to only the current slide or to all the 
slides and the slide master. 
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Activity 7 -  Changing the Background Fill (Colors, Shading, Patterns, Picture):  

1.Display the slide you want to change. 

2.On the Format menu, click Background. The Background dialogue box appears, showing you the current 
color scheme and the current background in a drop box. 

3.There is an option to omit the background graphics that may have been applied when you chose a design 
template. 

4.Click the down arrow beside the colored box representing the current background. You may choose another 
color in the current color scheme or click on More colors... to choose a different color. Practice omitting the 
background graphics and changing the background color. 

 
 

5.From the drop down arrow choose Fill Effects. Explore the different options under the Gradient, Texture, 
Pattern, and Picture tabs. 

 

  
The Fill Effects options may also be used when formatting drawing objects and WordArt. 



 28

Return to index 

 
You have now completed this module. Take a few minutes to review and practice what you have learned. 
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Introduction to PowerPoint XP 

Module 6 

 

In this module, you will learn how to create a presentation from Outline View in PowerPoint XP.  

    Creating a Presentation From Outline View  

      Formatting Your Presentation 

Creating a Presentation From Outline View: Working with an outline is the best way to organize and develop the 
content of your presentation. 

 

Activity 1 - Creating a Presentation from Outline View  

1.Open PowerPoint to a Blank Presentation, selecting a Blank layout. 

This is the Outlining Toolbar 

2.From the View – Tools menu, click the Outlining toolbar. Click the Outline tab and then click beside the icon 
of your first slide. The blinking cursor appears.  

 

3.Type the title of your slide (Introduction to PowerPoint) and press the “Enter” key  
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4.Click on the greenish-blue, right pointing arrow, type your first bullet (Presentations), and press “Enter”. 

5.Type your second bullet (Animations) and press “Enter”. 

6.Type your third bullet (Slideshows) and press “Enter”. 

7.Click on the greenish-blue, left pointing arrow to create your second slide. 

8. Create three more slides, experimenting with the arrows and formatting buttons to create slides without titles 
and without bullets.  Try selecting text and changing fonts, sizes and colors. 

Your Outline should look like the one in the screenshot below. 

 

 

  

You can rearrange points within a slide, move 
entire slides from one position to another, and 
edit titles and body text. For example, to 
rearrange slides or bullet items, just select the 
slide icon or bullet for the text you want to 
move, and then drag it to its new location. 

When you select text in the outline pane, 
buttons for working with outlines become 
available on the Standard and Formatting 
toolbars. You can use these buttons to quickly 
organize your presentation       —     for 

example, click Promote or Demote to 
increase or decrease the indent level of a bullet. 
You can also display all the buttons for working 
with outlines on a single toolbar. On the View 
menu, point to Toolbars, and then click 
Outlining. 
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Return to index  

 
Formatting Your Presentation: You may format your presentation in any of the ways you learned in the last 
module. The following activity reviews design templates and background formatting. 

 

Activity 2 - Formatting Your Presentation 

1.Go to Format – Slide Design, and preview the Design Templates 

2.Select one of the templates and click “Apply”. 

3.Go to Color Schemes on the Task Pane and look at the color scheme options for the design template you 
chose. 

4.Select one of the options and click either “Apply” or “Apply to All”. 

5.Go to Format - Background and click on the arrow beside the colored box to view background color options 

6.Click on “More Colors” and examine the “Standard” and “Custom” color palettes 

7.Go to Format - Background and click once more on the arrow beside the colored box. 

8.Click on “Fill Effects” and check out each of the tabs in the dialogue box 

9.In the Format - Background window, notice the check box option that allows you to omit background 
graphics from your slide. 

Return to index  

 
You have now completed this module. Take a few minutes to review and practice what you have learned. 
 
 
 
 
 
 
 
 
 
 
 
 
 



 32

 

Introduction to PowerPoint XP 

Module 7 

 

  

In this module, you will follow step by step directions to create a presentation. During the exercise 
you will complete the following activities:  

      Start PowerPoint; Apply a Design Template; Enter Text 

   Insert a New Slide; Create a Bulleted List 

     Save Your Presentation  

   Insert a New Slide; Enter Text; Navigate From Slide to Slide; Preview Your Presentation in 
Slideshow View 

    Create a New Slide; Insert Clipart 

   Create and Format a Drawing Object 

   View in Slide Sorter;  Apply Slide Transitions 

Start PowerPoint; Apply a Design Template; Enter Text 

 

Activity 1 - Start PowerPoint; Apply a Design Template; Enter Text 

1.      Open PowerPoint from the “Start” button 

2.      Select a design template of your choice and click “Apply” 

5.      Type SIMPLE MACHINES 

6.      Click in the subtitle area and type CHAPTER FIVE REVIEW 
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At the end of this activity your 
presentation should look similar to 
this one. Notice that there is only 
one slide at this point. 

Return to index 

 
Insert a New Slide; Create a Bulleted List  

 

Activity 2 - Insert a New Slide; Create a Bulleted List  

1.      Click on the “Insert New Slide” button or use the Insert - New Slide menu command 

2.      Select the “Bulleted List” slide layout and click “OK” (you could double click the “Bulleted List” 
option) 

3.      Type SIX SIMPLE MACHINES 

4.      Click in the text area and type the following, pressing the “Enter” key after each entry except the last: 

Lever 

Wheel and Axle 

Pulley 

                                                Inclined Plane 
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                                                Screw 

                                                Wedge 

   

 

At the end of this activity your 
presentation should look similar to 
this one. You now have two slides 
in your presentation. 

Return to index 

 
Save Your Presentation  

 

Activity 3 - Save Your Presentation  

1.   Save your presentation as SIMPLE MACHINES (if the computer asks if you want to replace the existing 
SIMPLE MACHINES, click YES 

Return to index 

 
Insert a New Slide; Enter Text; Navigate From Slide to Slide; Preview Your Presentation in Slideshow View  
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Activity 4 - Insert a New Slide; Enter Text; Navigate From Slide to Slide; Preview Your Presentation in 
Slideshow View 

1.      Create a third slide by clicking on the “New Slide” button, selecting “Bulleted List” and clicking “OK” 

2.      Type SIMPLE MACHINES in the title area 

3.      Click in the text area and enter the following bullets: 

                                      Increase Force 

                                      Change the Direction of Force 

                                      Increase and Change the Direction of Force 

4.      Use the double arrow buttons on the scroll bar to move back to slide one 

5.      Click on the “Slide Show” button on the bottom scroll bar 

6.      Click the mouse button repeatedly to view each slide until PowerPoint exits the slide show 

7.      Save your work in progress by clicking on the “Save” button on the Standard Toolbar (looks like a 
diskette) 

 

  

At the end of this activity your 
presentation should look similar to 
this one. You now have three slides 
in your presentation. 

Return to index 
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Create a New Slide; Insert Clipart  

 

Activity 5 - Create a New Slide; Insert Clipart  

1.      Use the scroll bar to move to slide 2, and insert a new slide by clicking on the “New Slide” button 

2.      Select the “Title Slide” layout and click “OK” 

3.       Type COMPOUND MACHINES 

4.       Click in the subtitle area and Type: “A Combination of Simple Machines That Does the Work of 
Several  Simple Machines” 

5.       Insert a new slide (select the “Text and Clip Art” option) 

6.       Type MACHINES 

7.       Click in the text area and enter the following bullets: 

Make Work Easier 

Do Not Reduce the Amount of Work to Be Done 

8.       Double click on the clip art area 

 9.      Scroll through the available clip art and select an appropriate picture 

 10.    Click on “Insert”. Close the Clip Gallery. 
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At the end of this activity your 
presentation should look similar to 
this one. You now have five slides 
in your presentation. 

Return to index 

 
Create and Format a Drawing Object  

 

Activity 6 - Create and Format a Drawing Object  

1.      Move back to slide 1 

2.      From the drawing tool bar select the “AutoShapes” button 

3.      Point to “Stars and Banners” and click on the 5-Pt. Star tool 

4.      Move your pointer back to the slide (notice that it changes into a crossbar or drawing tool) 

5.      Position the drawing tool just under your title, press and hold the “Shift” key, then click, hold and drag the 
drawing tool to create a star (holding down the “Shift” key will make the star proportional) 

6.      If necessary, reposition the star by clicking, holding, and dragging 

7.      Resize the star, if necessary, by clicking on it to produce sizing handles, then placing your pointer on a 
corner handle, then clicking and dragging 

8.      Make sure the star is selected (click once on it to select it) and go to Format - AutoShape 
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9.      On the “Colors and Lines” tab, in the “Fill” section, click on the arrow beside the colored bar and choose 
a  yellow color 

10.    In the same area, choose “Fill Effects” and select one of the gradient options 

11.    In the “Lines” area, choose “No Line” (click on the arrow beside the colored bar) and click “OK” 

12.    Save your changes 

 

  

At the end of this activity your 
presentation should look similar to 
this one. You still have five slides in 
your presentation. 

Return to index 

 
View in Slide Sorter;  Apply Slide Transitions 

 

Activity 7 - View in Slide Sorter;  Apply Slide Transitions 

1.      Click on the “Slide Sorter View” button on the bottom scroll bar 

2.      From the “Edit” menu, choose “Select All” 

3.      From the “Slide Show” menu, select “Slide Transition” 
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4.      Select “Random Transition” from the bottom of the drop down menu 

5.      Select “Automatically After _ Seconds” and type 4, then click “Apply” 

6.      Under “View”, select “Slide Show”! 

   

 

  

Congratulations! Your presentation 
should look like this in Slide Sorter 
View. You may rearrange the order 
of the slides by clicking and 
dragging. You may want to practice 
this and return them to the correct 
order when through. 

Return to index 

 
You have now completed this module. Take a few minutes to review and practice what you have learned. 
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Introduction to PowerPoint XP 

Module 8 

 

  

In this module, you will build upon the presentation that you created in the previous module. You 
will learn how to use preset animations, insert and configure background music, and apply custom 
animation. 

    Applying preset animation to  your presentation 

    Download, insert, and configure a background music file 

    Applying custom animation to objects in your presentation 

Applying preset animation to  your presentation 

 

Activity 1 - Applying preset animation to  your presentation 

1. Open "SIMPLE MACHINES" if necessary 

2. Switch to Slide Sorter View 

3. Go to Edit - Select All 

4. Go to Slide Show – Animation Schemes and select one of the presets. Apply to all.  

5. Click on the Slide Show button on the bottom Scroll Bar 

6. Practice applying other preset animations (Use the Esc key to stop a slideshow) 

7. When you are through, remove any preset animation by selecting Slide Show – Animation Schemes – No 
Animation 

Return to index 
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Download, insert, and configure a background music file 

Activity 2 - Download, insert, and configure a background music file 

1. If necessary, download the music file "Sunmoon.mid". You will be given the file path.  

2. Double Click on the first slide to switch to Slide View 

3. Go to Insert - Movies and Sounds - Sound From File 

4. In the “Look In” box, go to the directory where your resources are stored 

5. In the “Files of Type” box, click on “All files” 

6. Double Click on the midi file Sunmoon.mid 

7. You are asked if you want the file to play automatically. Click Yes. 

8. On the slide Transition task Pane, click on the “Custom Animation” button. Then click the down arrow 
beside the media clip and click on Effect options  
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You insert a music, sound, or 
video clip on a slide where 
you want it to play during a 
slide show. You can choose 
either to have the sound or 
video start automatically 
when you move to the slide, 
or to have the sound or video 
start only when you click its 
icon during a slide show. To 
change how the clip starts or 
to add a hyperlink to the clip, 
click Action Settings on the 
Slide Show menu. 

You can also add animation 
effects and change play 
settings by clicking Custom 
Animation on the Slide 
Show menu. For example, 
you can set a sound or video 
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to play automatically in an 
animation sequence. 

Return to index 

 
Applying custom animation to objects in your presentation 

 

Activity 3 - Applying custom animation to objects in your presentation  

1. Go to Slide Two  

2. Select the text box containing the list of simple machines  

3. From the Slideshow menu click the Custom Animation button  



 44

 

4. Select an object, either text or picture and click the Change button  

 

5. Make your choices and click the “Play” button to preview, the click “OK”  

6. When you are finished, save your work and exit PowerPoint. 

 

 
ASSIGNMENT ONE DUE!!! 

Save your work! This completed document will be used as your first assignment. In order to 
receive a certificate for course completion,  you must send this document as an email attachment to 
the following address: cgeorge@wresa.org . Be sure to include your name and LEA and the 
name of the course in the body of your email. 
You have now completed this module. Take a few minutes to review and practice what you have learned. 
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Introduction to PowerPoint XP 

Module 9 

 

  

In this module, you will create your own original presentation. This presentation should be a 
minimum of ten slides and should include formatted text, clipart, music, animations, slide 
transitions, and custom backgrounds. The subject matter is your choice.  

    Creation of an original presentation 

Creation of an original presentation 

 

Activity 1 - Creation of an original presentation 

Using all the skills you have developed, create a presentation for on-screen viewing.  The presentation should 
be a minimum of 10 slides. 

 
ASSIGNMENT TWO DUE!!! 

Save your work! This presentation will be used as your second assignment. In order to receive a 
certificate for course completion,  you must send this presentation as an email attachment to the 
following address: cgeorge@wresa.org. Be sure to include your name and LEA and the name 
of the course in the body of your email. 
Congratulations! You have now completed this course! 
 


